
Chapter 15

Surface Modeling
  Learning Objectives  
After completing this chapter, you will be able to:
•  Create an extruded surface
•  Create a revolved surface
•  Create a sweep surface
•  Create a blended surface
•  Create a swept blend surface
•  Create a helical sweep surface
•  Create a surface by blending boundaries
•  Create a surface by using variable section sweep
•  Create surfaces by using Style environment
•  Understand surface editing tools
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SURFACE MODELING
Surface models are a type of three-dimensional (3D) models with no thickness. These models 
are widely used in industries like automobile, aerospace, plastic, medical, and so on.

Surface models should not be confused with thick models. Thick models are the models having 
mass properties. Surface models do not have thickness whereas thick or solid models have a 
user-defined thickness. In Creo Parametric, surface modeling techniques and feature creation tools 
are same as those used in solid modeling. A solid model created of any shape can also be created 
using the surface modeling techniques. Sometimes, it is difficult to create complex shapes using 
solid modeling. Such models can be easily created using surface modeling and then the surface 
model can be converted into a solid model. It becomes easy for a person to learn surface modeling 
if he is familiar with solid modeling feature creation tools.

CREATING SURFACES IN Creo Parametric
In Creo Parametric, you can toggle between a solid feature and a surface feature while creating 
a protrusion. The two buttons that are used to toggle between the solid feature and a surface 
feature are available on dashboards.

Creating an Extruded Surface
  Ribbon:  Model > Shapes > Extrude     

To create an extruded surface, choose the Extrude tool from the Shapes group; the Extrude 
dashboard will be displayed, as shown in Figure 15-1.

Figure 15-1  Partial view of the Extrude dashboard

In this dashboard, the Extrude as solid button is chosen by default. Choose the Extrude as 
surface button to extrude the sketch and create a surface model. All attributes of a solid 
model that were discussed in Chapter 4 are the same for a surface model. Some examples 

of these attributes are sketching plane, both-side or one-side extrusion, depth of extrusion, and 
so on.

A surface model can be extruded with capped ends or with open ends. Figure 15-2 shows the 
open ends surface model and Figure 15-3 shows the capped ends surface model. Remember 
that to create the capped end surface model, the sketch should be a closed loop. However, a 
surface can be created with the open sketch. 

To create a surface with capped ends, select the Capped Ends check box in the Options 
slide-down panel.
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Figure 15-3  Surface with capped endsFigure 15-2  Surface with open ends

Creating a Revolved Surface
  Ribbon:  Model > Shapes > Revolve     

To create a revolved surface, choose the Revolve tool from the Shapes group; the Revolve 
dashboard will be displayed, as shown in Figure 15-4. This feature creation tool works in 

the same way as in the case of solid modeling. 

Figure 15-4  Partial view of the Revolve dashboard

In the Revolve dashboard, the Revolve as solid button is chosen by default. Choose the 
Revolve as surface button to create a revolve surface. You can create a revolved capped 

end surface or an open end surface. The Capped Ends check box in the Options slide-down 
panel is available only when the sketch is closed and the angle of revolution is less than 
360 degrees. Figure 15-5 shows the revolved surface with open ends and Figure 15-6 shows the 
revolved surface with capped ends. 

Figure 15-6  Revolved surface with capped endsFigure 15-5  Revolved surface with open ends

Creating a Sweep Surface
  Ribbon:  Model > Shapes > Sweep drop-down> Sweep     

To create a sweep surface feature, choose the Sweep tool from the Sweep drop-down in 
the Shapes group of the Model tab in the Ribbon; the Sweep dashboard will be displayed. 

The method to create a surface sweep feature is the same as that to create a solid sweep feature. 
To create a solid sweep feature, refer to Chapter 9. The additional option of capping the ends 
that was available in the Extrude and Revolve tools is also available in the Sweep tool.
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Figures 15-7 and 15-8 show the sweep surfaces with the open and capped ends, respectively.

Figure 15-7  Sweep surface with open ends 
created using a closed sketch

Figure 15-8  Sweep surface with capped 
ends created using a closed sketch

Creating a Blend Surface
  Ribbon:  Model > Shapes > Blend     

To create a surface blend, choose the Blend tool from the expanded Shapes group in the 
Ribbon; the Blend dashboard will be displayed. In this dashboard, the Blend as solid 

button is chosen by default. Choose the Blend as surface button to blend the sketch and create 
a surface model. The method to create a blend surface is the same as that to create a solid blend. 
To create a solid blend feature, refer to Chapter 9. Blended surfaces can be with open ends or 
capped ends. Figure 15-9 shows the blend surface with open ends and Figure 15-10 shows the 
blend surface with capped ends.

Tip
If you want to create a surface blend with capped ends, you need to create a closed sketch. Creo 
Parametric does not accept an open sketch for a capped end blend surface.

Figure 15-10  Blend surface with capped endsFigure 15-9  Blend surface with open ends 

Creating a Rotational Blend Surface
  Ribbon:  Model > Shapes > Rotational Blend     

To create a rotational blend surface, choose the Rotational Blend tool from the expanded 
Shapes group in the Ribbon; the Rotational Blend dashboard will be displayed. In this 

dashboard, the Blend as solid button is chosen by default. Choose the Blend as surface button 
to create a surface model. The method to create a rotational blend surface is the same as that 
to create a solid rotational blend. To create a solid rotational blend feature, refer to Chapter 9. 
Rotational blend surface can be created with open ends or capped ends. Figure 15-11 shows the 
rotational blend surface with open ends and Figure 15-12 shows the rotational blend surface 
with capped ends.
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Figure 15-11  Rotational blend surface with 
open ends created using a closed sketch 

Figure 15-12  Rotational blend surface with 
capped ends

Creating a Swept Blend Surface
  Ribbon:  Model > Shapes > Swept Blend     

To create a swept blend surface, choose the Swept Blend tool from the Shapes group in 
the Ribbon; the Swept Blend dashboard will be displayed. Choose the Create a surface 

button to create a sweep surface. The method to create a swept blend surface is the same as that 
to create a solid swept blend feature. To create a solid swept blend feature, refer to Chapter 9. 
Figure 15-13 shows the swept blend with open ends and Figure 15-14 shows the swept blend 
with capped ends.

Figure 15-13  Swept blend surface with 
open ends and an open sketch

Figure 15-14  Swept blend surface with 
capped ends

Creating a Helical Sweep Surface
  Ribbon:  Model > Shapes > Sweep > Helical Sweep     

To create a helical sweep surface, choose the Helical Sweep tool from the Sweep drop-down 
of the Shapes group in the Ribbon; the Helical Sweep dashboard will be displayed. Choose 

the Create a surface button to create a sweep surface. The method to create a helical sweep 
surface feature is the same as that to create a solid helical sweep feature. For more information 
on creating solid helical sweep features, refer to Chapter 9. Figure 15-15 shows the helical sweep 
surface with open ends and Figure 15-16 shows the helical sweep surface with capped ends.
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Figure 15-15  Helical sweep surface with open 
ends created using an open sketch

Figure 15-16  Helical sweep feature with capped 
ends created using the closed sketch

Creating a Surface by Blending Boundaries
  Ribbon:  Model > Surfaces > Boundary Blend     

To create a surface by blending boundaries, datum curves, or points, choose the Boundary 
Blend tool from the Surfaces group in the Ribbon; the Boundary Blend dashboard 

will be displayed, as shown in Figure 15-17 and you will be prompted to select two or more curve 
chains to define a blended surface. The options and buttons in this dashboard are discussed 
next.

 Figure 15-17  Partial view of the Boundary Blend dashboard
Curves Tab
When you choose the Curves tab, the slide-down panel will be displayed. Choose a curve from 
the drawing area; the curve will be highlighted in green and the value 0.00 will be displayed 
on both ends of the curve. When you modify this value, the curve will change accordingly at 
the corresponding end. Press CTRL+left mouse button to select the second curve; the second 
curve will also get highlighted, refer to Figure 15-18. These curves will be numbered as per the 
sequence of selection. The surface created by using these two blending boundaries is shown in 
Figure 15-19.

The collector present above the Curves tab shows 2 Chains. The number of curves selected in 
the first direction will be displayed in this collector.
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Figure 15-19  Surface created by blending 
boundaries

Figure 15-18  Curves selected as the blending 
boundary

Now, invoke the Curves slide-down panel, refer to Figure 15-20 and select 2 Chain from the 
First direction collector. The Move up and Move down buttons available in the slide-down 
panel are used to change the order of selection of the curves. The Close blend check box is 
used to close the surfaces.

Figure 15-20  The Curves slide-down panel

Tip
To delete curves from the collector, select the curve in the collector and right-click and choose 
the Remove all option from the shortcut menu; all the curves available in the collector will 
be deleted.

Figure 15-21 shows the surface created by using four curves and Figure 15-22 shows the surface 
created by selecting the Close blend check box.
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Figure 15-21  Surface created after selecting 
the curves

Figure 15-22  Surface created by selecting the 
Close blend check box

The Second direction collector in the Curves slide-down panel is used to select curves in the 
second direction. The second direction curves are usually drawn in a direction other than that 
of the first direction. Figure 15-23 shows the first and second direction curves and Figure 15-24 
shows the surface created after selecting the curves shown in Figure 15-23.

Figure 15-23  Datum curves Figure 15-24  Surface created by using 
the first and second direction curves

Creating a Variable Section Sweep Surface by Using the 
Sweep Tool
  Ribbon:  Model > Shapes > Sweep     

To create the variable section sweep surface, choose the Sweep tool from the Shapes group 
in the Ribbon; the Sweep dashboard will be displayed. Choose the Sweep as surface button 

from the dashboard. To learn more about the variable section sweep, refer to Chapter 9. The 
procedure of creating a variable section sweep surface is similar to the procedure for creating 
variable section sweep as was discussed in Chapter 9.

Figure 15-25 shows the section and trajectories used to create the variable section sweep surface. 
You have an option to keep the ends open or capped. This option is available in the Options 
slide-down panel.
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Figure 15-25  Variable section sweep surface with open ends

Creating a Curve Using the Intersect Option
  Ribbon:  Model > Editing > Intersect     

The Intersect option can be invoked by choosing the Intersect tool from the Editing group. 
This option is an object action tool, therefore you need to select a datum plane and then invoke 
this option. The Intersect option creates a datum curve at the intersection of a face of the model 
and a datum plane, intersection of a face of the model and a quilt surface, intersection of a quilt 
surface and a datum plane. Note that you cannot create a datum curve at the intersection of two 
datum planes, or two model faces using this option.

When you choose this option, the Intersect dashboard appears, as shown in Figure 15-26.

Figure 15-26  Partial view of the Intersect dashboard

To create a ring on the circumference of the cylindrical feature, as shown in Figure 15-27, you 
need to create a datum curve that is on the circumferential surface of the cylindrical feature 
and then use the Sweep tool. 

Figure 15-27  Ring on the circumference of the 
cylindrical feature
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To create the datum curve that lies on the outer surface, follow these steps:

1. Select the datum plane that is intersecting with the circumferential surface of the cylinder.

2. Choose the Intersect tool from the Editing group; the Intersect dashboard is displayed.

3. Choose the References tab to open the slide-down panel. In the Surfaces collector, the 
selected datum plane is displayed.

4. Use CTRL+left mouse button to select the top or bottom circumferential surfaces of the 
cylindrical feature, as shown in Figure 15-28.

5. Choose the OK button from the dashboard to exit the feature creation tool. The datum 
curve is created on the circumferential surface of the cylinder, as shown in Figure 15-29.

Figure 15-28  Selections made on the model Figure 15-29 Datum curve created on the 
circumferential surface of the cylindrical feature

Creating a Curve Using the Project Tool
  Ribbon:  Model > Editing > Project     

The Project tool is used to project a selected or sketched entity on one or more planar or 
non-planar surfaces or datum planes. The projected datum curve forms a true projection of 
the selected or sketched entity on the specified surfaces. The dimensions of the original entity 
may distort while projecting.

Choose the Project tool from the Editing group; the Projected Curve dashboard is displayed, 
as shown in Figure 15-30. The tools and options in this dashboard are discussed next.

Figure 15-30  The Projected Curve dashboard
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Surfaces Collector
The Surfaces collector is used to select the surface on which you need to project the sketched 
or selected datum curve.

Direction Drop-down List
The Direction drop-down list is used to specify the method of projection of the datum curve 
on the receiving surface or plane. The two options available in this drop-down list are: Along 
direction and Normal to surface, and are discussed next.

Along direction
If you use this option, then the datum curve is projected in the direction indicated by the 
pink arrow. To specify the direction of projection, select the datum plane, edge, or surface. 
Figure 15-31 shows the top view of the projected datum curves that are overlapping. The 
datum curve that is selected to project on the receiving surface and the datum curve after 
projection are of same geometry. This is because, using the Along direction option, the 
true geometry is obtained after projection. Figure 15-32 shows the sketched datum curve 
after it has been projected on a receiving surface. The curve is sketched on a datum plane 
that is parallel to the bottom face of the model.

Figure 15-31  Top view of the projected datum 
curve

Figure 15-32  Projecting a datum curve along 
the specified direction

Normal to surface
This option of projecting a datum curve projects the datum curve normal to the receiving 
surface. Figure 15-33 shows a datum curve selected to be projected on a receiving surface 
and the datum curve after projection. Figure 15-34 shows the sketched datum curve after 
the projection on the receiving surface.
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Figure 15-33  Top view of the projected datum 
curve

Figure 15-34  Projecting a datum curve

References Tab
This tab is used to define the references for projection. If you choose the References tab, a 
slide-down panel is displayed, as shown in Figure 15-35. This slide-down panel is used to select 
the datum curve to be projected or sketch a datum curve to project. The drop-down list in the 
slide-down panel lists three options: Project chains, Project a sketch, and Project a cosmetic 
sketch. Using these options, you can project multiple chains or a sketch on a surface or face. 
These options are discussed next.

Project chains
The Project chains option is used when the datum curve to be projected exists. Click 
in the Chains collector to make it active and then select the datum curve that you need 
to project. After selecting the datum curve, click in the Surfaces collector and select 
the receiving surface (plane or surface to project on to). Then you need to specify the 
direction of projection. Remember that if you are using the Normal to surface option, 
then you do not need to specify the direction of projection. The Direction Reference 
collector is displayed while selecting the Along direction option from the dashboard, whereas 
it does not appear while selecting the Normal to surface option.

Project a sketch
When you select the Project a sketch option from the drop-down list in the References 
slide-down panel, a slide-down panel appears, as shown in Figure 15-36.

Click on the Sketch collector and then select a curve or sketch to be projected or create a 
sketch that can be projected on the sketch. To create a new sketch, choose the Define button 
to invoke the Sketch dialog box and to select the sketch plane for the curve to be projected. 
After sketching, exit the Sketcher environment and select the surface or plane on which the 
curve will be projected. If you are using the Along direction option to project the curve then 
you need to click in the Direction Reference collector to specify the direction of projection.
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Figure 15-35  The References slide-down panel 
with the Project chains option selected

Figure 15-36  The References slide-down panel 
with the Project a sketch option selected

Project a cosmetic sketch
When you select the Project a cosmetic sketch option from the drop-down list of the 
References slide-down panel, a slide-down panel will be displayed which is similar to the 
Project a sketch slide-down panel. Click on the Sketch collector and then select a cosmetic 
sketch to be projected or create a sketch that can be projected on the sketch. To create a new 
cosmetic sketch, choose the Define button to invoke the Sketch dialog box and then select 
the sketch plane for sketching the curve. After sketching, exit the Sketcher environment and 
select the surface or plane on which the curve needs to be projected.

Creating a Curve Using the Wrap Option
  Ribbon:  Model > Editing > Wrap     

This option is used to create a datum curve by wrapping a sketched entity around a solid or a 
quilt. Choose the Wrap tool from the expanded Editing group, the Wrap dashboard will be 
displayed, as shown in Figure 15-37. The tools and options in this dashboard are discussed next.

Figure 15-37  Partial view of the Wrap dashboard

References Tab
When you choose the References tab, a slide-down panelwill be displayed, as shown in 
Figure 15-38. The Define button available in this slide-down panel is used to invoke the Sketch 
dialog box.
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The Destination collector in the slide-down panel is used

Figure 15-38  The References 
slide-down panel

 
to select the object on which you need to wrap the curve. 
Generally, if there is a single feature in the drawing area, 
then you do not need to select the object to wrap on. 
Creo Parametric automatically wraps the selected curve or 
the sketched curve on the object. However, if you want to 
select a different object to wrap on then you can click in this 
collector to make it active and then select the object.

Options Tab
On choosing the Options tab, a slide-down panel will be displayed,

Figure 15-39  The Options 
slide-down panel

 
as shown in Figure 15-39. There are two options available in this 
panel. The Ignore intersection surface check box when selected, 
ignores intersection surface, if any and wraps the selected curve on 
the destination object.

The Trim at boundary check box when selected, trims the extra 
portion of the curve that is beyond the boundary of the destination 
object.

Follow the steps given below to sketch and wrap a curve on

Figure 15-40  Curve wrapped on the 
rectangular block

 
the rectangular block, as shown in Figure 15-40. It is 
assumed that the rectangular block of dimension 20x20x50 
exists.

1. Choose Wrap tool from the Editing group to invoke 
the Wrap dashboard.

2. Choose the References tab to invoke the slide-down 
panel.

3.  Choose the Define button to invoke the Sketch dialog 
box.

4.    Choose the datum plane that is passing through the center of the rectangular block as the 
sketching plane and then choose a reference for orienting the sketching plane.

5. After entering the Sketcher environment, draw a line that starts from the bottom of the 
rectangular block. Its start point is aligned with the center of the rectangular block and 
with the bottom edge. The endpoint of the line is at a distance of 1000 and at a height of 
50 from the bottom of the rectangular block, refer to Figure 15-41.
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Figure 15-41  Sketch of the curve to be wrapped

6. Place a user-defined coordinate system at the start point of the line.

7. Exit the Sketcher environment; the sketched curve will be automatically wrapped on the 
circumference of the cylinder.

8. Choose the OK button to exit the dashboard.

CREATING SURFACES BY USING THE STYLE 
ENVIRONMENT OF Creo Parametric
  Ribbon:  Model > Surfaces > Style     

Style is an environment available in Creo Parametric and is used to draw free style curves 
and create surfaces by joining them. The surfaces created using the Style environment are 

called Super features. This is because these features can contain any number of curves or surfaces. 
The Style surfaces can be joined with the Creo Parametric surfaces. They can have the parent-child 
relationship among themselves and also with Creo Parametric features.

To enter the Style environment, choose the Style tool from the Surfaces group. Figure 15-42 
shows the appearance of the Style environment.
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Figure 15-42  The Style environment

Style Dashboard
Figure 15-43 shows the Style dashboard in the Style environment. The options in this dashboard 
are discussed next.

Figure 15-43  The Style dashboard

Set Active Plane
  Ribbon:  Style > Plane > Set Active Plane drop-down > Set Active Plane     

The Set Active Plane tool is available in the Set Active Plane drop-down in the Plane 
group of the Style dashboard in the Ribbon. This tool is used to select the datum plane 

on which the drawing or the editing operation needs to be performed. The datum plane that 
you select is highlighted by a mesh. Also, horizontal and vertical directions are shown on the 
selected plane.

Internal Plane
  Ribbon:  Style > Plane > Set Active Plane drop-down > Internal Plane     

The Internal Plane tool is available in the Set Active Plane drop-down in the Plane group 
of the Style dashboard. This tool is used to create an internal datum plane in the Style 

environment. When you choose this tool, the Datum Plane dialog box will be displayed. This 
dialog box is used to create a datum plane in a similar procedure that was discussed in Chapter 5. 
The datum planes are named as DTM1, DTM2, and so on.
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It should be noted that the datum planes created by using this tool will be displayed in the drawing 
area only when you are in the Style environment. Once you exit the Style environment, these 
datum plane become invisible. Any feature created in the Style environment will be displayed 
in the Style Tree as a style feature.

Curve
  Ribbon:  Style > Curve > Curve drop-down > Curve     

The Curve tool is available in the Curve drop-down of the Curve group in the Style 
dashboard. This tool is used to draw curves. When you choose this tool, the Style: Curve 

dashboard will be displayed, as shown in Figure 15-44. The options in this dashboard are discussed 
next.

Figure 15-44  The Style:Curve dashboard

Create a Free Curve
In the Style:Curve dashboard, the Create a Free Curve button is chosen by default. 
As a result, you will be prompted to define the points for creating the curve. To create 

the curve, click on the screen. A green point will be displayed at the location where you have 
clicked. Now, again click to define the second point of the curve. The two points are joined 
by a line. When you click to define the location of the third point, you will notice that the 
curve that you are drawing is defined by a spline. After defining the points, press the middle 
mouse button to create the curve. While specifying a point, if you press the SHIFT key, then 
the point is snapped to the entity already present on the screen.

 Remember that the curve drawn using the Create a Free Curve button will lie on the active 
datum plane. To draw a 3D curve, you need to snap the point on the existing entity. You 
can also draw a 3D curve by choosing the Show All Views button from the Graphics toolbar 
and then selecting a point each from any of the two different windows. When you choose 
the Show All Views button, the four-window view is displayed. In Creo Parametric, this type 
of display is called a 4-view display mode. The 4-view display mode shows the top, default, 
right, and front views. You can select a point in one window and then select the second point 
in the other window. By specifying points in different windows, the 3D curve can be drawn. 
To switch back to the single window display mode, choose the Show All Views button again.

Tip
To undo the last operation, choose the Undo button from the Quick Access toolbar or press 
CTRL+Z keys.

Create a Planar Curve 
This tool, when selected, allows you to create the curve on the datum plane that is 
highlighted by the mesh. This datum plane is called the active plane. The active plane 

can be selected after invoking the Style: Curve dashboard by choosing the Set Active Plane 
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button from the Style: Curve dashboard. The Set Active Plane button is available on the 
right of the dashboard.

Tip
Using the Planar option, you can project a point of an existing entity on the active datum 
plane. This can be done by selecting the point on the entity using the SHIFT key. The selected 
point is projected on the active datum plane.

Create a Curve On Surface
This tool is used to draw curves on surfaces. The points that you define on a surface 
are constrained to that surface. When you click to define the location of the first point 

of the curve, the point is placed. Now, this surface will be selected and the points placed 
hereafter should lie on the same surface. If you click outside this surface, then the point is 
not placed on the surface. After the curve is drawn, press the middle mouse button. The 
orange curve is converted to a black curve indicating that the curve is completed. The curve 
drawn on the surface is the child of the surface.

Edit this curve using control points
 If this toggle button is chosen while drawing the curve, then on editing the curve the 

control points will be displayed.

Proportional Update
 If you create a curve, when this check box is selected, then the curve created can be edited 

proportionally.

Tip
Using the Free option, you can draw a curve on a surface. To draw a curve on a surface, press 
SHIFT to select a point on the surface. The surface will be highlighted as you select a point 
on it and then the point will be placed on it. This method of selecting points on a surface can 
be used to draw curves that join points on two separate surfaces.

Circle
  Ribbon:  Style > Curve > Curve > Circle     

The Circle tool is used to create circles. To create circles, choose Circle from the Curve 
drop-down in the Curve group of the Style dashboard; the Style: Circle dashboard will be 
displayed. Click anywhere in the drawing area; a circle with default radius will be placed at 
that location. The circle thus created can be free or planar circle. By default, the Create a Free 
Curve button is chosen in the dashboard, and therefore the curve created will be a free curve. 
You can adjust the radius of the circle by dragging the handle or enter the radius value in the 
edit box. The circles can also be edited similar to curves. You can also select the Proportional 
Update check box to edit the circle proportionally.

Similarly, you can create arcs by choosing the Arc button from the Curve drop-down. 
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Curve Edit
  Ribbon:  Style > Curve > Curve Edit     

The Curve Edit button is used to edit the curves that are created as style features. If you 
choose this button, the Style: Curve Edit dashboard will be displayed, as shown in 

Figure 15-45 and you will be prompted to select a curve. Select the curve; the curve will be 
displayed in the collector of the Curve Edit dashboard.

Figure 15-45  Partial view of the Style: Curve Edit dashboard

The options in the Style: Curve Edit dashboard are discussed next.

Curve Collector
When you select a curve to edit, the id of the curve will be displayed in this collector.

Change to a Free Curve
The Change to a Free Curve button is used to change the selected curve into a free 
curve.

Change to a Planar Curve
The Change to a Planar Curve button is used to change the selected curve into a 
planar curve.

Change to a Curve on Surface
If the curve selected for editing is drawn using the Curve On Surface option, then 
the Change to a Curve on Surface button will be selected by default.

Proportional Update Check Box
If the curve selected for editing is drawn by selecting the Proportional Update check box, 
then the curve will be edited proportionately with the points.

Edit this curve using control points       
If the curve that for editing is drawn using the Edit this curve using control points 
button, then the control points will be displayed on the curve. Using these control 
points, you can modify the shape of the curve. You can also choose this button to 
display the control points on a curve drawn without choosing this button.

Tangent
Choose the Tangent tab to define the nature of contact between the curve and the adjacent 
surface. Alternatively, select one of the end control points of the curve, the tangent vector of 
the curve will be highlighted in green color. Now, right-click on the green vector to display 
the shortcut menu, as shown in Figure 15-46.
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Figure 15-46  Shortcut menu for the end control 
point of the curve

By default, a curve has a natural contact with the adjacent surface. This is evident from 
the circle mark on the left of the Natural option in the shortcut menu. Figure 15-47 shows 
the curve that is connected to the adjacent surface using the Natural option. The curve is 
drawn using the Free option. The point on the cylindrical surface will be selected by using 
SHIFT+left mouse button and similarly another point will be selected on the surface at the 
base. Figure 15-48 shows the curve whose contact type is changed to the Surface Tangent 
option by choosing it from the shortcut menu.

Figure 15-48  Curve joining the base surface 
tangentially

Figure 15-47  Curve joining the two surfaces

Drop Curve
  Ribbon:  Style > Curve > Drop Curve     

Using the Drop Curve tool, a curve created in the Style environment can be projected 
onto the selected surface.
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To project a curve on a selected surface, choose the Drop Curve tool from the Curve group of 
the Style dashboard to create COS (Curve On Surface); you will be prompted to select the curve 
that you need to drop onto the surface. Select the curve and press the middle mouse button. 
Now, you will be prompted to select the surface on which you need to drop the curve. Select the 
surface; you will be prompted to select the plane normal to which the curve will be dropped. 
Select the plane normal to which the curve will be projected and exit the dashboard.

Curve on Surface by Intersect
  Ribbon:  Style > Curve > COS by Intersect     

The Curve on Surface by Intersect tool is used to create a curve at the intersection of two 
sets of surfaces. To do so, choose COS By Intersect from the Curve group in the Style 

dashboard; you will be prompted to select the first set of surfaces. Select the required surfaces. 
Next, click the middle mouse button to accept the selection and then select the second set of 
surfaces or planes and choose the OK button to create the COS at the intersection.

Surface
  Ribbon:  Style > Surface > Surface     

The Surface tool is used to create a surface among a closed boundary of curves. Choose 
the Surface tool from the Surface group in the Style dashboard; the Style: Surface 

dashboard will be displayed and you will be prompted to select boundary curves to define a 
surface. For example, to create surface using four curves, as shown in Figure 15-49, select these 
four curves with the CTRL key pressed. After selecting these four curves, press the middle mouse 
button; the surface will be created, as shown in Figure 15-50.

Figure 15-49  Four curves Figure 15-50  Surface created using the curves

Surface Connect
  Ribbon:  Style > Surface > Surface Connect     

The Surface Connect tool is used to connect two Style surfaces. Style surfaces can also be 
connected to Creo Parametric surfaces using this tool. When you choose this tool, the 

Style: Surface Connection dashboard will be displayed and you will be prompted to select two 
surfaces. By pressing the CTRL key, select the two surfaces, as shown in Figure 15-51, and then 
press the middle mouse button; the connections will be applied to the two surfaces. These 
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connections may be of two types: curvature and tangent. If the tangent connection is applied, 
then the arrow will be displayed and if the curvature connection is applied, then a dashed line 
will be displayed on the surfaces. Figure 15-52 shows the two surfaces where the tangent 
connection as well as the curvature connection has been applied.

Figure 15-52  Surfaces after applying connectionsFigure 15-51  The two surfaces

Choose the Surface Connect tool from the Surface group of the Style dashboard; the Style: 
Surface Connection dashboard will be displayed, as shown in Figure 15-53, and you will be 
prompted to select the two surfaces. Select the surfaces. To apply the connection, click on any 
one end of the dashed line; the dashed line will be converted to an arrow, indicating that the 
two surfaces are connected. To remove the connection, use SHIFT+left click on the arrow. 
Figure 15-54 shows the style surface when it is connected by using curvature connection and 
Figure 15-55 shows the surface when it is connected tangentially.

Figure 15-53  Partial view of Style: Surfaces Connection dashboard

Figure 15-55  Surface connected at top by using 
the tangent connection

Figure 15-54  Surface connected at top by using 
curvature connection
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Note
To delete a curve, select the curve and when it turns green, press the DELETE key.

Surface Trim
  Ribbon:  Style > Surface > Surface Trim     

The Surface Trim tool is used to trim a surface. When you choose this tool, the Style: 
Surface Trim dashboard will be displayed and you will be prompted to select the surface(s) 

to trim. Select the surface to trim and then press the middle mouse button; you will be prompted 
to select the curve that can be used to trim the surface. Select the curve and press the middle 
mouse button. The selected surface will be highlighted in two portions. Select the portion to 
delete. Choose the OK button from the dashboard to exit the trim tool. 

Figure 15-56 shows the surface and the curve that are selected for trimming. This figure also 
show the surface divided into two portions. The portion defined by the curve will be selected to 
delete. Figure 15-57 shows the surface after trimming.

Figure 15-56  Surface and curve selected for 
trimming

Figure 15-57  Surface after trimming

Note
After completing the Style feature creation, choose the OK button from the Close group in the Style 
dashboard to exit the Style environment.

SURFACE EDITING TOOLS 
The surface editing tools help in decreasing the modeling time. They also help in creating 
complex surface models. The surface editing tools that you will be learning in the next section 
are as follows:

1. Mirror   4.   Fill     7.   Thicken
2. Merge   5.   Intersect   8.   Solidify
3. Trim   6.   Offset   9.   Vertex Round
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Mirroring the Surfaces
  Ribbon:  Model > Editing > Mirror     

The Mirror tool is used to mirror the surface about a plane. This tool is available in the 
Editing group only when a surface is selected. When you choose this tool, the Mirror 

dashboard will be displayed, as shown in Figure 15-58.

Figure 15-58  Partial view of the Mirror dashboard

Click in the Mirror plane collector, you can choose the mirroring plane from drawing area. 
The Dependent Copy check box in the Options tab is selected by default. This makes sure 
that the parent-child relationship is maintained between the mirrored and original surfaces. 
Figure 15-59 shows the mirror plane and Figure 15-60 shows the mirrored feature.

Figure 15-59  The mirror plane and the 
surface to be mirrored

Figure 15-60  Surfaces after mirroring and 
keeping the original surface

Merging the Surfaces
  Ribbon:  Model > Editing > Merge     

The Merge tool is used to merge two surfaces and make them a single surface. To convert a 
surface into a solid, it is necessary that the surfaces are merged. While merging the surfaces, 
this tool also trims them. This tool will be enabled in the Editing group only when the two 
surfaces to be merged are selected. When you choose the Merge tool, the Merge dashboard will 
be displayed, as shown in Figure 15-61.

Figure 15-61  Partial view of the Merge dashboard
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The following steps explain the procedure to merge the surfaces, as shown in Figure 15-62.

1. Select the Quilts option from the Filter drop-down list. Select the two surfaces and when 
they are highlighted, choose the Merge tool; the Merge dashboard will be displayed. While 
merging the two surfaces, the part of the surfaces that will be retained after the two surfaces 
are merged is highlighted by dots on it. The arrows point to the direction in which the 
surfaces are retained. The direction of arrow can be toggled by clicking on them or by using 
the Change side of first quilt to keep and Change side of second quilt to keep buttons 
of the Merge dashboard. You can also click on the arrows to flip the direction in which the 
surfaces are retained.

2. Choose the Change side of first quilt to keep button and then choose the Change side of 
second quilt to keep button. Notice that the outer side of the surfaces are highlighted with 
dots, as shown in Figure 15-63. 

Figure 15-62  Two surfaces to be merged Figure 15-63  Arrows showing the part of the 
surface to retain

3. Choose the Preview button to verify the desired trim and then exit the dashboard by choosing 
the OK button. The resulting merged surface is shown in Figure 15-64. This merged surface 
is a single surface and now can be converted to a solid feature.

The Reference tab of the Merge dashboard shows the

Figure 15-64  Resulting merged surface

selected quilts. In the Options tab, you can select 
between Intersect and Join options. The Join option 
can be used when the edge of one quilt lies on the 
other quilt.

  Note
While working with more than two surfaces or quilts, 
it should be checked that the selection of quilts in the 
References tab is in proper order.

Trimming the Surfaces
  Ribbon:  Model > Editing > Trim     

As the name suggests, the Trim tool is used to trim the selected surfaces by using a 
trimming object. Select the surface that you need to trim and then choose the Trim tool 

from the Editing group; the Trim dashboard will be displayed, as shown in Figure 15-65. Also, 



15-26              Creo Parametric 4.0 for Designers

you will be prompted to select the trimming object. This trimming object can be a curve, plane, 
edge, or a surface.

Figure 15-65  Partial view of the Trim dashboard

The part of the surface that is to be retained is highlighted with dots. Also, an arrow is displayed, 
pointing in the direction of the surface to be retained after trimming. You can choose the 
Flip between one side, other side, or both sides of trimmed surface to keep button from 
the dashboard or click on the arrow to toggle the direction. By default, the trimming surface 
is deleted after the surfaces are trimmed. If you need to keep the trimming object, select the 
Keep trimming surface check box from the Options slide-down panel. Figure 15-66 shows the 
surface selected as the trimming object, the trimming surface, and the arrow. It is evident from 
this figure that the arrow is pointing toward the right; therefore, the right portion of the surface 
will be retained after trimming. Figure 15-67 shows the surface obtained after trimming.

Figure 15-66  Surface and object to be trimmed Figure 15-67  Surface obtained after trimming

Creating the Fill Surfaces
  Ribbon:  Model > Surfaces > Fill     

The Fill tool is used to create a planar surface by sketching its boundaries. When you 
choose this option from the Surfaces group of the Ribbon, the Fill dashboard will be 

displayed, as shown in Figure 15-68.

Figure 15-68  Partial view of the Fill dashboard
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Choose the References tab; a slide-down panel will be displayed. Choose the Define button 
from it to select the sketching plane and draw the sketch. Figure 15-69 shows the sketch plane 
and Figure 15-70 shows the surface that is created by using the Fill tool.

Figure 15-69  The sketch plane for creating 
the fill surface

Figure 15-70  Fill surface created using the 
Fill tool

Creating the Intersect Curves
  Ribbon:  Model > Editing > Intersect     

The Intersect tool is used to create a curve at the intersection of two surfaces. The intersect 
curve can then be used for various purposes. The Intersect tool is available in the Editing 

group only when you have selected a surface. When you choose this option from the Editing 
group, the Surface Intersection dashboard will be displayed, as shown in Figure 15-71.

Figure 15-71  Partial view of the Surface Intersection dashboard

When you select the second surface, the intersecting curve will be created, as shown in 
Figure 15-72. Make sure to select the second surface by holding the CTRL key. The curve 
created can be copied, moved, and so on. One of the uses of the intersect curve is shown in 
Figures 15-73 and 15-74.  

Figure 15-72  Surfaces selected to create the intersecting curve
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In Figure 15-73, the intersecting curve is copied at a distance of 1250. The Boundary Blend 
tool is used to create the surface shown in Figure 15-74. To create the boundary blend, the 
intersecting curve will be selected and then the curve edge of the surface will be selected. Both 
the curves are blended and the tangency is increased by dragging the handles.

Figure 15-73  Copied curve Figure 15-74  Boundary blend created using 
the intersecting curve

Creating the Offset Surfaces
  Ribbon:  Model > Editing > Offset     

A surface can be copied to an offset distance. To offset a surface, select the surface to offset and 
then choose the Offset tool from the Editing group in the Ribbon; the Offset dashboard will 
be displayed, as shown in Figure 15-75. The Offset tool will be available only when you select 
a surface to offset. 

Figure 15-75  Partial view of the Offset dashboard

In Creo Parametric, there are three methods to offset a surface. These methods are as follows:

1. Create the offset of the whole surface using the Standard Offset Feature option.
2. Sketch a section and offset the area inside the section with the draft using the With Draft 

Feature option.
3. Sketch a section and offset the area inside or outside the section using the Expand Feature 

option.

In the Offset dashboard, first you need to specify the type of offset surface you need to create. 
The types of offset that can be created in Creo Parametric are as follows: Standard Offset Feature, 
With Draft Feature, Expand Feature, and Replace Surface Feature.
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Standard Offset Feature
The Standard Offset Feature tool is present at the upper-left corner of the Offset dashboard 
and is chosen by default. You can enter the offset value in the dimension edit box.

This option can be used to offset the surface as a whole. From the drop-down list in the Options 
slide-down panel, the Normal to Surface option is selected by default. This option allows you to 
offset a surface normal to the surface. If you select the Automatic Fit option from the drop-down 
list, then Creo Parametric automatically fits the surface, or controls the direction of the offset 
in the X, Y, and Z axes. If you select the Controlled Fit option from the drop-down list in the 
Options slide-down panel, you need to select a coordinate system and specify the direction to 
offset. You can also join the offset surface with the side surfaces by selecting the Create side 
surface check box. Figure 15-76 shows the original surface and the offset surface.

Figure 15-76  The original and offset surfaces

With Draft Feature
The With Draft Feature tool is available in the drop-down that appears by selecting the 
black arrow present on the right of the Standard Offset Feature tool. Using this tool, you 

can sketch the section and then give a draft angle to the side surfaces. Choose the Define button 
from the References slide-down panel to define a sketching plane and to create the sketch of 
the draft surface. Figure 15-77 shows the draft offset surface with the Straight radio button 
selected from the Options slide-down panel. The section drawn on the sketching plane is circular. 
Similarly, Figure 15-78 shows the draft offset surface with the Tangent radio button selected 
from the Options slide-down panel.

Figure 15-77  Draft offset surface with 
straight profile

Figure 15-78  Draft offset surface with 
tangent profile
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Expand Feature
The Expand Feature tool can be chosen from the list of tools that appear by selecting 
the down arrow present on the right of Standard Offset Feature tool. Using this option, 
you can sketch the section and then choose whether to offset the inside or the outside of 

the sketch. For this purpose, you need to choose the Change direction of offset to the other 
side button from the dashboard. Alternatively, click on the arrow displayed on the model. 
Figure 15-79 shows the offset surface when the inside of the sketch is selected to offset. The 
section that was drawn on the sketching plane was rectangular. Choose the Define button from 
the Options slide-down panel to define the sketching plane and create the sketch. Figure 15-80 
shows the draft offset surface when the outside of the sketch is selected to offset.

Figure 15-79  Inside of the sketch selected 
to offset

Figure 15-80  Outside of the sketch selected 
to offset

Replace Surface Feature
The Replace Surface Feature tool is used to replace a specified face of a solid with a quilt 
or datum plane. It can add or remove material from the solid. To create a replacement 

surface, select the face to be replaced and then choose the Offset tool from the Editing group 
of the Ribbon; the Offset dashboard will be displayed. Choose the down arrow present on the 
right of the Standard Offset Feature tool; a list of tools will be displayed. Choose the Replace 
Surface Feature button; you will be prompted to select the surface or datum plane to replace. 
Select the replacement surface; the preview of the modified solid feature will be displayed. 
Choose the OK button to accept the preview and create the feature. Figure 15-81 shows the face 
of the solid selected to be offset and the replacement surface. Figure 15-82 shows preview of the 
modified solid feature.

Figure 15-81  The offset and replacement 
surfaces

Figure 15-82  Preview of the modified 
solid feature
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Adding Thickness to a Surface
  Ribbon:  Model > Editing > Thicken     

To add thickness to a quilt or a surface, select the quilt and choose the Thicken option from the 
Editing group; the Thicken dashboard will be displayed, as shown in Figure 15-83.

Figure 15-83  Partial view of the Thicken dashboard

Drag the handle to set thickness of the quilt or enter the thickness value in the dimension edit 
box. You can even remove material from the quilt by choosing the Removes material from 
inside thickened quilt button from the dashboard.

Using the drop-down list in the Options slide-down panel, you can give thickness to the quilt 
normal to the surface. Creo Parametric automatically scale the surface along the axes and fit the 
original surface with respect to the coordinate system. If you select the Controlled Fit option 
from the drop-down list in the Options slide-down panel, you need to select a coordinate system 
and specify the direction to scale.

Figures 15-84 and 15-85 show the surfaces after adding thickness by using the Normal to surface 
and Automatic fit options, respectively.

Figure 15-84  Thickening the surface by using the Normal to surface option 

Figure 15-85  Thickening the surface using the Automatic fit option
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Converting a Surface into a Solid     
  Ribbon:  Model > Editing > Solidify     

You can convert a closed surface into a solid by choosing the Solidify tool from the Editing 
group of the Ribbon. This option is available only when a closed surface with capped ends is 
selected. This option fills the hollow surface with material.

Creating a Round at the Vertex of a Surface
  Ribbon:  Model > Surfaces > Vertex Round     

The vertices of a surface or quilt can be rounded by using the Vertex Round option. To do so, 
choose Vertex Round from the expanded Surfaces group of the Ribbon; the Vertex Round 
dashboard will be displayed, as shown in Figure 15-86. Also, you will be prompted to select a 
vertex to add round.

Figure 15-86  Partial view of the Vertex Round dashboard

Select the corner vertex(s) to be rounded. Select the first vertex and then press the CTRL key to 
select the other vertex, as shown in Figure 15-87. After selecting the vertices, enter the radius 
value in edit box available in the dashboard. Choose the OK button from the Vertex Round 
dashboard; the vertices will be rounded, as shown in Figure 15-88.

Figure 15-87  Vertices selected to be rounded Figure 15-88  Vertices after creating round

FREESTYLE MODELING ENVIRONMENT
  Ribbon:  Model > Surfaces > Freestyle     

The Freestyle Modeling is a surfacing environment which encompasses qualities of 
both the NURBS and polygon surfaces. NURBS surfaces are smooth surfaces 

controlled by CV points and the polygon surfaces give the flexibility to extrude a specific area 
of the surface for detailing. Features created in the Freestyle Modeling environment are called 
Freestyle features. These features can be created at the beginning of modeling in Creo Parametric. 
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You can invoke the Freestyle Modeling environment by choosing the Freestyle tool from the 
Surfaces group of the Model tab in the Ribbon.

Freestyle Dashboard
When you invoke the Freestyle tool from the Surfaces group of the Model tab in the Ribbon, 
the Freestyle dashboard is displayed, as shown in Figure 15-89. The options in this dashboard 
are discussed next.

Figure 15-89  Partial view of the Freestyle dashboard

Primitives          
A primitive is the first feature required to proceed further to

Figure 15-90  The Shapes 
drop-down

 
create a model in the Freestyle Modeling environment. All 
operations available in the Freestyle Modeling environment 
are performed on the primitive. Primitives are available in the 
Shapes drop-down of the Operations group in the Freestyle 
dashboard, refer to Figure 15-90. It is important to note that 
you can create only one primitive at a time in the Freestyle 
Modeling environment. If you want to create more primitives 
then you need to invoke the Freestyle environment again. There 
are two categories of primitives available in the Shapes 
drop-down: Open Primitives and Closed Primitives. The 
Open Primitives category contains two-dimensional primitives 
that are created in the XY plane. The Closed Primitives 
category contains three-dimensional primitives which are 
created with coordinate system at its center. To create a 
primitive, click on the desired primitive icon; the primitive will 
be created in the drawing area. You can change the reference 
coordinate system by using the Freestyle Options dialog box. This dialog box is displayed when 
you choose the Options button from the drop-down of the Operations group, refer to 
Figure 15-91.

To change the coordinate system, click in the Reference CSYS collector in the References area 
and select the desired reference coordinate system. You can also change the increment value of 
the 3D Dragger in the linear or angular direction.

Transform        
The Transform tool in the Manipulation group of the Freestyle dashboard is used to transform 
the primitive. This tool will be activated only when you select any face, edge, or vertex of the 
primitive. Figure 15-92 shows a rectangle primitive with a vertex selected. Figure 15-93 shows 
the deformed primitive after dragging the 3D Dragger along the Y direction. You can rotate 
and drag the 3D Dragger along any of the direction available.
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Figure 15-91  The Freestyle Options dialog box

Figure 15-92  A rectangle primitive 
with a vertex selected

Figure 15-93  The deformed primitive after 
dragging the 3D Dragger along Y direction

Scale      
The Scale tool in the Manipulation group of the Freestyle dashboard will be activated only when 
you select any face, edge, or vertex of a primitive. Note that the scaling operation cannot be 
performed on a vertex. To apply scaling, you need to select an edge or a face. When you select an 
edge or a face and choose the Scale tool from the dashboard, the 3D Dragger is displayed without 
the circular handles. Select any of the axes or planes of the 3D Dragger to scale the primitive. 

Reposition          
The Reposition tool is activated in the Manipulation group of the Freestyle dashboard only 
when you select any face, edge, or vertex of a primitive. Using the Reposition tool, you can 
reposition the 3D Dragger by rotating or translating it along any of the available axes.
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Align          
Using the Align tool, you can align the primitives along any of the datum planes or planar 
surfaces. This tool will be activated in the Associate group of the Freestyle dashboard only when 
you select any face or edge of a primitive. To align a primitive along a datum plane, select the 
primitive, choose the Align tool from the dashboard, and then select the datum plane along 
which you want the primitive to be aligned. 

Planarize          
The Planarize tool is used to make all the selected vertices lie in a single plane. This tool will 
be activated in the Manipulation group of the Freestyle dashboard only when you select any 
face, edge, or vertex of a primitive. When you invoke this tool after selecting the primitive, a 
default plane is displayed in which the vertices will lie. You can press the middle mouse button 
to accept the default plane or you can select a plane along which the vertices will be planarized.

Increment          
The Increment tool is activated in the Manipulation group of the Freestyle dashboard only 
when you select any face, edge, or vertex of a primitive. When the Increment toggle button is 
selected, the increment value will also be displayed during the

Figure 15-94  The extruded 
feature of a rectangle primitive

 
manipulation of the primitive.

Extrude          
The Extrude tool is available in the Create group of the Freestyle 
dashboard and will be activated only when you select any face or 
edge of a primitive. The Extrude tool available in the Freestyle 
environment works in the same way as in the Modeling environment. 
When you select any face and then choose the Extrude tool from 
the dashboard, all the edges of the selected face are converted into 
walls. Figure 15-94 shows  extruded feature of a rectangle primitive.

Edge Split          
The Edge Split drop-down list is available in the Create group of the

Figure 15-95  The Edge 
Split drop-down list

 
Freestyle dashboard and will be activated only when you select an edge 
of a primitive. After selecting an edge, click on the down arrow at the 
right of the Edge Split button, a drop-down list will be displayed, as 
shown in Figure 15-95. Now, select the desired option, the selected edge 
will split into desired number of equal pieces. 

Face Split          
The Face Split drop-down list is available in the Create group of the

Figure 15-96  The Face 
Split drop-down list

 
Freestyle dashboard and will be activated only when you select a face of 
a primitive. After selecting the face, click on the down arrow at the right 
of the Face Split button, a drop-down list will be displayed, as shown in 
Figure 15-96. Select the desired option from the menu; the selected face 
will split into five pieces of selected offset percentage.
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Connect          
The Connect tool is used to join two or more edges. This tool is available in the Create group of 
the Freestyle dashboard and will be activated only when you select two or more faces or edges of 
a primitive. Note that you can select more than one edge or face by holding the CTRL key while 
selecting the entities. After selecting two or more faces or edges, choose the Connect tool from 
the Create group of the dashboard; the faces or edges will be joined together and the resultant 
surface will be displayed. Figure 15-97 shows a deformed rectangle with two edges to be selected 
for connecting. Figure 15-98 shows the output after connecting the edges.

Figure 15-97  A deformed rectangle with 
two edges to be selected for connecting

Figure 15-98  The output after 
connecting the edges

 

Mirror   
The Mirror tool is available in the Mirror drop-down of the Connect Mirror drop-down of the 
Symmetry group in the Freestyle dashboard and will be activated only when you select an edge 
or a face of the primitive. After selecting an edge or a face, choose the Mirror tool; you will be 
prompted to select the datum plane or planar surface as a mirror plane. Select the mirror plane, 
the edge or face will be mirrored along with the control points. 

Connect Mirror   
The Connect Mirror tool is available in the Symmetry group of the Freestyle dashboard and 
will be activated only when you select a face of the surface mirrored earlier. Figure 15-99 shows 
a mirrored surface and the face to be selected for the mirror connect operation. Figure 15-100 
shows the output surface. 

Figure 15-100  The output surfaceFigure 15-99  A mirrored surface and the face 
to be selected for the mirror connect operation
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Dependent 
The Dependent toggle button is available in the Symmetry group of the dashboard. When this 
toggle button is selected, the control mesh of mirrored feature is dependent on the original 
feature. But when this button is not selected, the mirrored feature is controlled by its own 
control mesh. Figure 15-100 shows the default output surface created by using the Connect Mirror 
tool which is a dependent mirrored surface and Figure 15-101 shows the independent mirrored 
surface. 

Figure 15-101  An independent mirrored surface

Delete Mirror/Change Plane 
You can delete the mirrored surface by selecting the Delete Mirror option available in the Mirror 
drop-down. You can change the mirror plane by selecting the Change Plane option available 
in the Mirror drop-down.

TUTORIALS
Tutorial 1

In this tutorial, you will create the surface model shown in Figure 15-102. The orthographic 
views of the surface model are shown in Figure 15-103.        (Expected time: 45 min)

Figure 15-102  The surface model
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Figure 15-103  Top, front, and right views of the surface model

 Examine the model and determine the number of features in it, refer to Figure 15-102. 

 The following steps are required to complete this tutorial:

a. Create the base feature, which is a blend surface, refer to Figures 15-104 through 15-106. 
b. Create the second feature, which is a blend feature, refer to Figures 15-107 and 15-108. 
c. The third feature is a mirror feature. It will be created by mirroring the second feature about 

a plane that passes through the center, refer to Figure 15-109. 
d. Create the fourth feature, which is also a blend feature, refer to Figures 15-110 and 15-111.
e. Select the surfaces individually and merge them, refer to Figures 15-112 and 15-113. 
f. Remaining features are the fill features and they will be used to create surfaces on the blend 

features, refer to Figures 15-114 through 15-116. 
g. Create rounds on the edges and save the model, refer to Figure 15-117.

Starting a New Object File
1. Start a new part file and name it c14tut1.
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 The three default datum planes are displayed in the drawing area. The Model Tree is also 
displayed in the drawing area. Close the Model Tree by clicking on the sash present on its 
right edge.

Creating the Base Feature
 You need to create the base feature by using the Blend option.

1. Choose the Blend tool from the expanded Shapes group; the Blend dashboard is displayed.

2. Choose the Blend as surface button from the dashboard. Choose the Options tab and select 
the Straight radio button. Choose the Sections tab from the dashboard; a slide down panel 
is displayed. Select the Sketched sections radio button and choose the Define button from 
the slide down panel to define the sketching plane.

3. Select the RIGHT datum plane as the sketching plane. 

4. Select the TOP datum plane as reference plane and then select the Top option from the 
Orientation drop-down list. Choose the Sketch button to enter the sketcher environment.

5.   Draw an arc and dimension it, as shown in Figure 15-104.

6. After drawing the first arc, choose the OK button to exit the sketcher environment. Choose 
the Insert button from the Section tab; an offset value edit box with a default value will 
be available in the dashboard and in the Sections tab. Enter -150 in offset value edit box 
for depth of second section. Choose the Sketch button from the Sections tab to enter the 
sketcher environment.

7. Draw the second arc and dimension it, as shown in Figure 15-105.

Figure 15-104  Sketch of the first arc Figure 15-105  Sketch of the second arc

8. After drawing the second arc, choose the OK button to exit the sketcher environment. 
Choose the OK button from the dashboard to exit it. The model, similar to the one shown 
in Figure 15-106, is displayed in the drawing area.
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Figure 15-106  Trimetric view of the base feature

Creating the Second Feature
 The second blend feature will be created on the FRONT datum plane and it will pass through 

the center of the base feature.

1. Choose the Blend tool from the expanded Shapes group; the Blend dashboard is displayed.

2. Choose the Blend as surface button from the dashboard. Choose the Options tab and select 
the Straight radio button. Choose the Sections tab from the dashboard; a slide down panel 
is displayed. Next, select the Sketched sections radio button and then choose the Define 
button to define the sketching plane.

3. Select the FRONT datum plane as the sketching plane. 

4. Select the TOP datum plane as the reference plane and then select the Top option from the 
Orientation drop-down list. Choose the Sketch button to enter the sketcher environment.

5. Sketch an arc of radius 35; for the remaining dimensions refer to Figure 15-103 and then 
choose the OK button to exit the sketcher environment. Choose the Insert button from the 
Section tab and enter 150 in the offset value edit box for depth of second section. Choose 
the Sketch button from the Sections tab to enter the sketcher environment. 

6. Draw the second arc of radius 25, as shown in Figure 15-108.

7. Choose the OK button to exit the sketcher environment. Next, choose the OK button from 
the dashboard to exit it. The model, similar to the one shown in Figure 15-109, is displayed 
in the drawing area.

Figure 15-107  Sketch of the second feature Figure 15-108  Second feature created
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Creating the Mirror Copy of the Second Feature
 The third blend feature is the same as the second blend

Figure 15-109  Surface model 
after creating the third feature

 
feature. Therefore, a mirror copy of the second blend feature 
will be used to create the third feature.

1. Select the second feature and then choose the Mirror tool; 
the Mirror dashboard is displayed and you are prompted to 
select a plane to mirror about.

2. Select the FRONT datum plane and exit the Mirror 
dashboard by choosing the OK button. A mirror copy of the 
second feature is created, as shown in Figure 15-109.

Creating the Fourth Blend Feature
 The fourth blend feature will be created on the TOP datum plane and will pass through 

the center of the base feature.

1. Choose the Blend tool from the expanded Shapes group; the Blend dashboard is displayed.

2. Choose the Blend as surface button. Choose the Options tab and then select the Straight 
radio button. Also, select the Capped Ends check box. 

3. Choose the Sections tab from the dashboard to open the slide-down panel. Choose the 
Sketched sections radio button and then choose the Define button to define the sketching 
plane.

4. Select the TOP datum plane as the sketching plane. 

5. Select the RIGHT datum plane as the reference plane and then select the Top option from 
the Orientation drop-down list. Choose the Sketch button to enter the sketcher environment.

6. Sketch a circle of diameter 72; for the remaining dimensions refer to Figure 15-103 and then 
choose OK to exit the sketcher environment. Choose the Insert button from the Section tab 
and enter 150 in the offset value edit box for depth of second section. Choose the Sketch 
button from the Sections tab to enter the sketcher environment. 

7. Draw second circle of diameter 36, as shown in Figure 15-110.

8. Choose the OK button to exit the sketcher environment. Choose the OK button from the 
dashboard to exit it. The model, similar to the one shown in Figure 15-111, is displayed in 
the drawing area.

Merging the Surfaces to Create a Quilt
 To create a round on the edges, it is necessary to create a common edge where the two 

surfaces will join. For this purpose, the surfaces need to be merged.
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Figure 15-110  Sketch of the fourth 
blend feature

Figure 15-111  Model after creating 
the fourth blend surface  

Note
1. It’s easier to select two surfaces for merging from the Model Tree. You should remember that to 
select more than one surface, you need to press the CTRL key. When you select the surfaces from 
the Model Tree, their boundaries are highlighted, indicating that the surfaces are selected.

2. You can also choose the Quilts option from the Filter drop-down list to select the surfaces. The 
Filter drop-down list is available in the Status Bar at the right corner below the drawing area.

1. Select the blend surface on the left, press the CTRL key, and then select the blend in the 
middle. When the two surfaces are highlighted, choose the Merge tool; the Merge dashboard 
is displayed with two arrows showing the portion that will be retained after merging.

Note
The Merge button will be available only when two surfaces are selected for merging.

2. Choose the Change side of first quilt to keep button from the dashboard; the direction of 
the arrow changes.

3. Choose the Change side of second quilt to keep button from the dashboard; the direction 
of the arrow changes. The portion of the surface that is now highlighted will be retained 
after merging the surfaces.

4. Exit the dashboard by choosing the OK button. The model after merging the two surfaces 
is shown in Figure 15-112.

 
 Using the above procedure, merge the blend surface on the right with the merged surface. 

Next, merge the top blend surface with the merged surface. Figure 15-113 shows the surface 
model after merging all surfaces and forming a quilt.
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Figure 15-112  Surface model 
after merging the two surfaces

Figure 15-113  Surface model after 
merging all the surfaces

Creating the Fill Surfaces
 You need to create four surfaces to cap the ends of the blend surfaces. First, you will cap the 

left blend surface using the Fill tool.

1. Choose the Fill tool from the Surfaces group of the Model tab in the Ribbon; the Fill 
dashboard is displayed.

2. From the References slide-down panel, choose the Define button; the Sketch dialog box is 
displayed and you are prompted to select the sketching plane.

3. Choose the Plane tool from the Datum group of the Model tab; the Datum Plane dialog 
box is displayed.

4. Select the two vertices of the left blend surface. To select the second vertex, hold down the 
CTRL key and then select the FRONT datum plane. 

5. Select FRONT from the Datum Plane dialog box; a drop-down list appears in the row where 
you have clicked. Choose the Parallel option from the drop-down list and then choose the 
OK button from the Datum Plane dialog box.

 The datum plane is created and an arrow pointing in the direction of viewing the sketch is 
displayed.

6. Choose the Sketch button to close the Sketch dialog box to enter the Sketcher environment.

7. Choose the Project tool from the Sketching group and select the smaller semicircular edge 
of the blend surface. Next, close the sketch by drawing a horizontal line between the two 
ends, as shown in Figure 15-114.

8. Exit the Sketcher environment and then exit the Fill dashboard by choosing the OK button; 
the fill surface is created, as shown in Figure 15-115.
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Figure 15-114  Sketch for the fill 
surface

Figure 15-115  Surface after creating 
the fill surface

 Similarly, create the fill surfaces to cap the ends of the middle surface blend feature. Mirror 
the left fill surface to the right. Figure 15-116 shows the surface model after capping all the 
ends of the blend surfaces.

Figure 15-116  Surface model after creating the fill surfaces

Merging the Fill Surfaces
 The fill surfaces that you have created should be merged with the other surfaces in order 

to create a round on their edges.

1. Hold the CTRL key to select the fill surface that is on the left and the blend surface in the 
middle. When the two surfaces turn green in color, choose the Merge tool to display the 
Merge dashboard. 

2. Exit the dashboard by choosing the OK button.
 
 Using the same procedure, merge the remaining fill surfaces individually with the blend 

surface in the middle. To check whether all the surfaces have been merged, select the surface 
model. If the whole surface model is highlighted with green border then it indicates that 
all the surfaces have been merged and they form a quilt.

Creating Rounds
 When all the surfaces are merged, edges are formed at the intersection of two surfaces. 

These edges need to be rounded. In the given surface model, note that there are rounds 
that have two different radius values. Therefore, you need to create two sets to define two 
values of rounds.

1. Choose the Round button from the Engineering group.
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2. Select the edges having radius value 12; rounds of radii 12

Figure 15-117  Surface model 
after creating rounds

 
get created. 

 Remember that to select more than one edge, you need to 
hold down the CTRL key.

3. Choose the Sets tab to display the slide-down panel.

4. Click on New set; a set with the name Set2 is added.

5. Select the two edges that have radius of 15. After creating the 
rounds of radius 15, exit the Round dashboard.

 The surface model after creating the rounds is shown in 
Figure 15-117.

6. Choose the Save button from the File menu and save the model.

Tutorial 2
In this tutorial, you will create the surface model shown in Figure 15-118. The front and right views 
of the surface model are shown in Figure 15-119.                      (Expected time: 45 min)

Figure 15-118  Isometric view of the surface model
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Figure 15-119  Orthographic views of the surface model

 First, examine the model and determine the number of features in it, refer to Figure 15-118. 

 The following steps are required to complete this tutorial:

a. Create the base feature, which is an extruded surface with open ends, refer to Figures 15-120 
and 15-121. 

b. Create the second feature, which is a blend feature created at an offset distance of 65 from 
the RIGHT datum plane, refer to Figures 15-122 and 15-123. 

c.   The third feature is a mirror copy of the second feature, refer to Figure 15-124.
d.   The fourth feature is the cylindrical surface, refer to Figures 15-125 and 15-126. 
e. Create the two fill surfaces that will cap the ends of the base surface, refer to Figures 15-127 

through 15-129.
f. Merge all surfaces by selecting them individually, refer to Figures 15-130 through 15-132. 
g. Create the round features and save the model, refer to Figures 15-133 through 15-135.

Starting a New Object File
1. Start a new part file and name it c14tut2.
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Creating the Base Feature
 The base feature for this model is a surface between two blend surfaces. It will be created 

on the RIGHT datum plane.

1. Choose the Extrude tool from the Shapes group. 

2. Select the Extrude as surface button from the Extrude dashboard. Select the RIGHT datum 
plane as the sketch plane. 

3. Select the TOP datum plane as reference plane from the drawing area and then select the 
Top option from the Orientation drop-down list.

4. Choose the Sketch button to enter the Sketcher environment.

5. Create the sketch of the base feature and apply dimensions, as shown in Figure 15-120.

6. Choose the OK button to exit the Sketcher environment.

 The Extrude dashboard reappears above the drawing area. In this dashboard, the Extrude 
from sketch plane by specified depth value button is chosen by default.

7. Enter 240 in the dimension box present in the Extrude dashboard. Choose the OK button 
from the Extrude dashboard.

 The base feature is created and the default trimetric view of this feature is shown in 
Figure 15-121.

Figure 15-120  Sketch of the base surface Figure 15-121  Base surface with open ends

Creating the Blend Feature
 The second feature is a blend surface. It will be created on the FRONT datum plane and 

passes through the center of the base feature.

1. Choose the Blend tool from the expanded Shapes group; the Blend dashboard is displayed.

2. Choose the Blend as surface button from the dashboard. Choose the Options tab and select 
the Straight radio button. Choose the Sections tab from the dashboard; a slide down panel 
is displayed. Select the Sketched sections radio button and choose the Define button to 
define the sketching plane.
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3. Select the FRONT datum plane as the sketching plane. 

4. Select the TOP datum plane as the reference plane and then select the Top option from the 
Orientation drop-down list. Choose the Sketch button to enter the Sketcher environment.

5.    Draw an arc of diameter 55; for the remaining dimensions refer to Figure 15-119 and then 
choose OK to exit the Sketcher environment. Choose the Insert button from the Section 
tab; an offset value edit box with a default value will be available in the dashboard and in the 
Sections tab. Enter 65 in the offset value edit box for specifying the depth of second section. 
Next, choose the Sketch button from the Sections tab to enter the Sketcher environment.

6. Now, draw another arc of diameter 35, as shown in Figure 15-122.

7. After drawing the second arc, choose the OK button to exit the Sketcher environment. 
Choose the OK button from dashboard to exit it. The model, similar to the one shown in 
Figure 15-123, is displayed in the drawing area.

Figure 15-122  Sketch of the blend surface Figure 15-123  Blend surface

Mirroring the Blend Surface
 Next, you need to mirror the blend surface about the FRONT datum plane.

1. Select the blend surface and then choose the Mirror tool from the Editing group; the Mirror 
dashboard is displayed.

2. Select the FRONT datum plane and exit the dashboard; the blend surface is mirrored about 
the selected datum plane, as shown in Figure 15-124.

Figure 15-124  Model after creating the mirror copy of the blend surface

Creating the Cylindrical Surface
 The cylindrical surface will be created on the TOP datum plane. 
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1. Choose the Extrude tool from the Shapes group to display the Extrude dashboard.

2. Choose the Extrude as surface button from the Extrude dashboard.

3. Select the TOP datum plane as the sketching plane.

4. After entering the Sketcher environment, draw a circle and dimension it, as shown in 
Figure 15-125.

5. Exit the Sketcher environment and extrude the sketch to some appropriate depth, refer to 
Figure 15-126.

 The model after creating the surface extrusion is shown in Figure 15-126.

Figure 15-125  Sketch of the cylindrical surface Figure 15-126  Cylindrical surface

Creating the Fill Surface
 The fill surface will be created to cap the ends of the base feature.

1. Choose the Fill tool from the Surfaces group of the Model tab in the Ribbon; the Fill 
dashboard is displayed.

2. Choose the Define button from the References slide-down panel; the Sketch dialog box is 
displayed and you are prompted to select the sketching plane.

3. Select the RIGHT datum plane as the sketching plane. Choose the Flip button.

4. Select the TOP datum plane and select the Top option from the Orientation drop-down 
list. Choose the Sketch button to enter the Sketcher environment.

5. Choose the Project button and select the edges of the base feature. Create a line to join the 
ends of base feature; the sketch is completed, as shown in Figure 15-127.

6. Exit the Sketcher environment and then exit the Fill dashboard by choosing the OK button. 
On doing so, the fill surface is created, as shown in Figure 15-128.
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Figure 15-127  Sketch of the fill surface Figure 15-128  Model after creating the fill surface

7. Mirror the fill surface about the datum plane on-the-fly. This datum plane is at an offset 
distance of 120 from the RIGHT datum plane.

 After mirror copy of the fill surface is created, the other end of the base feature  also gets 
capped, as shown in Figure 15-129.

Merging the Blend Surface with the Cylindrical Surface
 The blend surface that was the second feature and the cylindrical surface will be merged to 

get the required circular slot.

1. Select the cylindrical surface and the blend surface by pressing the CTRL key. 

2. Choose the Merge button from the Editing group; the Merge dashboard is displayed and 
the surface that will be retained after merging is highlighted.

3. Choose the Change side of first quilt to keep button to change the direction of the pink 
arrow.

4. Exit the Merge dashboard by choosing the OK button. The model after merging the two 
surfaces is shown in Figure 15-130.

Figure 15-129  Model after creating the 
mirror copy of the fill surface

Figure 15-130  Model after merging the 
surfaces

Merging the Blend Surface and the Extruded Surface
 The blend surface and the extruded surface will be merged to build a single surface.
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1. Select the base feature and then select the Merge 1 feature from the Model Tree.

2. Choose the Merge button from the Editing group; the Merge dashboard is displayed and 
the surface that will be retained after merging is highlighted.

3. Choose the Change side of first quilt to keep and Change side of second quilt to keep 
buttons to change the direction of the pink arrow.

4. You can see the preview of the blend surface by choosing the Preview button in the dashboard. 
Exit the Merge dashboard by choosing the OK button. The model after merging the two 
surfaces is shown in Figure 15-131.

5. Similarly, merge the mirrored feature and the base feature. The surface model after merging 
the mirrored surfaces is shown in Figure 15-132.

Figure 15-132  Model after merging the mirror 
copy of the blend surface with the base surface

Figure 15-131  Model after merging the blend 
surface with the base surface

Merging the Fill Surfaces with the Base Surface
 The fill surfaces that you have created should be merged with the base surface in order to 

create a single quilt or a single surface. After merging the surfaces, you need to round the 
edges.

1. Select the fill surface and then select the base surface. 

Note
1. It is better to select surfaces to be merged from the Model Tree.

2. To merge two surfaces, it is necessary that they intersect each other.

2. Choose the Merge button from the Editing group and then choose the OK button to merge 
both the surfaces.

3. Similarly, merge the mirror copy of the first fill surface with the base surface. 

Creating Rounds
 You need to create rounds on the cylindrical slot or edges where the two blend surfaces 

merge and on the edges of the base surface.
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1. Choose the Round tool from the Engineering group. Select the edge of the cylindrical slot, 
refer to Figure 15-133; a preview of the round is highlighted on the selected edge.

2. Enter 4 in the dimension edit box for the radius of the round.

3. Click on New set in the Sets slide-down panel to add a second set named Set2. 

4. Select the four edges having radius 18. 
 
 Among these edges, the two edges are those that are formed by merging the two blend 

surfaces with the base surface and the other two edges are the top corners of the base surface, 
refer to Figure 15-133. 

5. Choose the OK button from the Round dashboard to create rounds. The surface model 
after creating the rounds is shown in Figure 15-134.

Figure 15-133  Edges selected to create rounds Figure 15-134  Resulting model after 
creating rounds on the selected edges

Creating a Full Round
 A full round will be created by selecting the two surfaces. These surfaces are the front and 

back faces of the base surface.

1. Choose the Round tool from the Engineering group. 

2. Select the two faces, front and back, of the base surface.

3. Invoke the slide-down panel by choosing the Sets tab. The selected surfaces are displayed 
in the References collector available in the slide-down panel. The Full Round button is 
chosen by default in the slide-down panel. 

 Now, you need to select the surface to be removed.

4. Select the top face of a base surface; the preview of the round is highlighted on the selected 
surfaces. Exit the Round dashboard by choosing the OK button. The round is created, as 
shown in Figure 15-135.
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Figure 15-135  Completed surface model

5. Choose the Save button from the File menu and save the model. 

Tutorial 3

In this tutorial, you will create the surface model of a table, as shown in Figure 15-136, using 
the Freestyle Modeling environment.              (Expected time: 45 min)

Figure 15-136  The surface model of a table

 First, examine the model and determine the primitive to be used. 

 The following steps are required to complete this tutorial:

a. Create a new coordinate system.
b. Create the primitive. 
c. Create the edge split feature, refer to Figures 15-139 through 15-142. 
d.   Create the third feature which is transformation of faces and save the model, refer to 

Figure 15-143 and 15-144.
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Starting a New Object File
1. Start a new part file and name it c14tut3.

Creating a New Coordinate System
 It is evident from the Figure 15-136, the model is created by using the square shape 

primitive on the Top plane. Therefore, you need to change the default sketching plane for 
the placement of primitive.

1. Choose the Coordinate System tool from the Datum group of the Model tab in the Ribbon; 
the Coordinate System dialog box is displayed.

2. Now, select the TOP plane from the Model Tree as a reference and the FRONT and RIGHT 
planes as offset references and then choose the OK button from the dialog box.

Starting the Freestyle Modeling Environment
 To start with the Freestyle Modeling environment, you need to follow the step given next.

1. Choose the Freestyle tool from the Surfaces group in the Model tab of the Ribbon while 
working in the Modeling environment; the Freestyle dashboard is displayed and Freestyle 
Modeling environment is activated.  

Changing the Sketching Plane
 You need to change the sketching plane. To do so, a coordinate system is required.

1. Click on the down arrow in the Operations

Figure 15-137  The Options dialog box

group in the Freestyle dashboard; a drop down 
list is displayed.

2. Choose the Options  button from this 
drop-down list; the Options dialog box is 
displayed, as shown in Figure 15-137.

3. Select the new coordinate system created earlier 
and choose the OK button from the dialog box.

Creating the Primitive
 After examining the model, you can guess that 

the basic primitive required for this model is a 
square surface. 

1. Choose the Choose a square initial shape 
option from the Open Primitives area of the 
Shapes drop-down list; a square surface is 
created in the XY plane, as shown in Figure 
15-138. 
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Figure 15-138  Square surface created

Creating the Edge Split Feature
 To create the legs of the table, you need to split the edges of the surface.

1. Select any of the four edges and click on the down arrow next to the Edge Split button in 
the Create group of the dashboard; a drop-down list is displayed.

2. Select the 4 Splits option from the drop-down list; the surface is displayed, as shown in the 
Figure 15-139.

Figure 15-139  Surface created after using the 4 Splits option

3. Select the two corner edges, as shown in Figure 15-140, and then choose the 4 Splits option 
again; the surface is split, as shown in Figure 15-141.

Figure 15-140  Surface with corners edges to be selected
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Figure 15-141  Surface with corner edges split by using the 4 Split option

 Similarly, split one edge perpendicular to the earlier selected edge so that the surface is 
displayed, as shown in Figure 15-142.

Figure 15-142  Surface model after splitting is completed

Transforming the Faces
 Now, you need to transform the corner squares to create legs of the table.

1.  Select the four small squares, as shown in Figure 15-143, and then drag the orange handle 
in z-direction such that the surface model looks like the one shown in Figure 15-144.

2. Choose the OK button and choose the Save button from the File menu to save the model.

Figure 15-143  Surface with the squares to be transformed
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Figure 15-144  Completed surface model

Self-Evaluation Test
Answer the following questions and then compare them to those given at the end of this 
chapter:

1. A feature created in the Style environment is displayed in the Model Tree as a __________ 
feature.

2. To enter the Style environment, choose the __________ tool from the Surface group in the 
Model tab. 

3. The __________ tool is used to merge two surfaces and form an edge.

4. In the Style environment, the __________ tool is used to draw curves.

5. A quilt is a __________ feature.

6. You can create a surface with capped ends by drawing an open sketch. (T/F)

7. Surface models have no thickness. (T/F)

8. Style features have the parent-child relationship among themselves as well as with 
the corresponding solid features created in the. (T/F)

9. In the Style environment, when you press the SHIFT key and select a point on a surface by 
using the Free option, the point is snapped on that surface. (T/F)

10. The procedure to create a helical sweep surface is the same as that of a solid helical sweep 
feature. (T/F)
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Review Questions

Answer the following questions:

1. Which of the following tools is used to create straight or smooth feature profile?

  (a) Sweep    (b) Blend
  (c) Extrude    (d) None of these

2. Which of the following editing tools is used to create a flat surface by drawing a sketch?

  (a) Trim    (b) Copy
  (c) Fill     (d) None of these

3. What is the minimum number of sections required for creating a blend feature?

  (a) one     (b) two
  (c) three    (d) None of these

4. Which of the following editing tools forms an edge between two intersecting surfaces?

  (a) Merge    (b) Intersect
  (c) Trim    (d) None of these

5. In which one of the following types of blend, sections are translated and rotated about the 
x, y, and z axes?

  (a) Parallel    (b) Rotational
  (c) General    (d) None of these
 
6. The Intersect option is used to create an intersect curve. (T/F)

7. In the Style environment, the Curve Edit tool is used to project curves on surfaces. (T/F)

8. Surface models are the 3D models with no thickness. (T/F)

9. In the Style environment, the Surface tool is used to select at least three or four curves and 
create a surface. (T/F)

10. To undo the last operation performed in the Style environment, choose the Undo button 
from the Quick Access toolbar. (T/F)
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EXERCISES
Exercise 1

In this exercise, you will create the surface model shown in Figure 15-145. The orthographic 
views of the surface model are shown in Figure 15-146.         (Expected time: 40 min)

Figure 15-145  Isometric view of the surface model

Figure 15-146  Orthographic views of the surface model
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Exercise 2
In this exercise, you will create the surface model shown in Figure 15-147. The orthographic 
views and the detailed view of the surface model are shown in Figure 15-148.   
               (Expected time: 55 min)

Figure 15-147  Surface model

Figure 15-148  Top, front, right, and detailed views of the surface model
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Exercise 3
In this exercise, you will create the surface model by using the sphere primitive shown in 
Figure 15-149 in the Freestyle modeling environment.         (Expected time: 55 min)

Figure 15-149  Top, front, right, and isometric views of the surface model

Front View Right View

Top View Isometric View
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Answers to Self-Evaluation Test
1. Style, 2. Style, Merge, 3. Merge, 4. Curve, 5. surface, 6. F, 7. T, 8. T, 9. T, 10. T


